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1. Einführung

Ich arbeite ehrenamtlich als EDV-Mentor im Jobmentoring Programm für geflüchtete
Menschen bei den Maltesern in München.
https://www.malteser.de/standorte/muenchen/jobmentoring.html

Hier versuche ich, in etwa 10 Unterrichtseinheiten den Menschen den Umgang mit einem
Computer, sowie konkret die Grundzüge der gängigen Office-Anwendungen am Beispiel
des Google-Office Paketes näherzubringen. Natürlich gibt es auch sehr gute Gründe, als
Beispiel das Office-Paket von Microsoft (MS-Word, MS-Powerpoint und MS-Excel) zu
verwenden. Bis auf die Tatsache, dass Google-Office rein “Cloud-basiert” verwendet wird,
liegen die Unterschiede aber eher in Details der Programmbedienung. Und da ein
“Cloud-basiertes” Arbeiten auch für manche Mentor*innen noch neu sein dürfte, gehe ich
darauf in diesem Kapitel auch etwas tiefer ein.

In erster Linie habe ich dieses Tutorial natürlich für mich und meine Lernenden
geschrieben. Es gibt bei den Maltesern auch bereits viele gute Tutorials (liegen im Schrank
des Begegnungsraumes in der Streitfeldstraße). Aber jeder hat seinen eigenen
Unterrichtsstil und eigene Schwerpunkte. Deshalb kann eine gewisse Vielfalt in den
Unterrichtsmaterialien auch nicht schaden.

Ich stelle dieses Tutorial ganz uneingeschränkt allen Interessierten zur Verfügung.
Ich habe auch absolut nichts dagegen, wenn jemand auf dieser Basis seine eigene Version
erstellt und mit eigenen Inhalten ergänzt. Kurze mail an mich, und ich gebe sie zum
Bearbeiten frei (wir sind Cloud-basiert, natürlich schicke ich auch gerne eine Version im
.docx Format ;-)

1.1 Vergleich Google-Office mit Microsoft-Office

Das Office Paket von Microsoft (insbesondere MS-Word, MS-Powerpoint und MS-Excel)
gehört sicherlich (immer noch) zu den am weitesten verbreiteten Standardanwendungen
in diesem Bereich.
Für Anwendungen im Privatbereich, sowie insbesondere auch für Geflüchtete sind damit
im Vergleich zu ähnlichen Paketen aber auch Nachteile verbunden:
- Relativ teuer (insbesondere die aktuellen Abo-Modelle von Microsoft 365)
- Erfordert einen eigenen Computer mit fester Installation

Es gibt mehrere kostenlose Alternativen wie z.B. OpenOffice, LibreOffice, Softmaker
Office oder Kingsoft Office. Alle diese Alternativen lehnen sich stark an das “Vorbild”
MS-Office an und versprechen auch Kompatibilität im Import und Export von Dateien.
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Ein weiterer Vertreter ist hier das Office-Paket von Google, welches als wesentliches
weiteres Merkmal komplett “cloud-basiert” ist. Das heißt

- Keine spezielle Software-Installation. Die Bedienung erfolgt ausschließlich über den
Webbrowser Google Chrome.

- Keine lokale Speicherung von Dateien erforderlich (außer bei Offline-Bearbeitung).
Die Dateien befinden sich auch in der Cloud (und lassen sich natürlich auch z.B. als
.pdf herunterladen).

- Ein Internetzugang ist erforderlich, sowie ein Google-Account. Bei fehlendem
Internetzugang ist aber auch eine Offline-Bearbeitung von Dateien möglich (sofern
man diese vorher bei bestehendem Netz erstellt und zur Offline-Bearbeitung
freigegeben hat). Wie in Punkt 1.4 noch genauer beschrieben wird, ist dies in
bestimmten Fällen (schlechte Internetverbindung bei Nutzung von öffentlichen
Computern) aber durchaus ein signifikanter Nachteil dieser Anwendung.

- Für gemeinsames Arbeiten an derselben Datei (Projektarbeit, aber auch zu
Unterrichtszwecken) entfällt das Hin- und Herschicken von Versionen. Es gibt dazu
ein Freigabesystem in der Cloud (siehe Übungsbeispiel 1.5).

In den folgenden Kapiteln werden die vier wesentlichen Komponenten des
Google-Office-Paketes kurz erklärt und jeweils mit einem einfachen Übungsbeispiel
vertieft.

Zum Abschluss dieser Einführung noch eine schematische Zuordnung der einzelnen
Office-Komponenten von Google und Microsoft:
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1.2 Installation

Voraussetzung zur Nutzung von Google-Office ist eine (kostenlose) Registrierung bei
Google. Der damit verbundene Account enthält zusätzlich auch einen email-Account
(@gmail.com), sowie einige weitere Dienste (Kalender, Foto-Archiv, Kontaktverwaltung,
Videokonferenz…). Dieser Account dürfte in vielen Fällen bereits bestehen (falls man gmail
nutzt, es ist genau dieser Account).

Zur Erstellung eines neuen Accounts die entsprechende Seite (s.u.) aufrufen und den
Anweisungen folgen. Für eine sichere Zwei-Faktor Authentifizierung ist dazu auch ein
Smartphone mit einer aktiven Telefonnummer erforderlich.

https://accounts.google.com/signup/v2/webcreateaccount?flowName=GlifWebSignIn&fl
owEntry=SignUp

Als zweite Voraussetzung benötigt man den Browser Google-Chrome. Auch dieser ist
wahrscheinlich in den meisten Fällen bereits installiert.

Falls nicht, die entsprechende Installationsdatei herunterladen..
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https://support.google.com/chrome/answer/95346?hl=de&co=GENIE.Platform%3DDeskt
op

…und den Installationsanweisungen folgen.

Ein weiterer Hinweis:

Das Google-Office Paket lässt sich auch von einem Android-Handy oder -Tablet aus
nutzen. Google Chrome ist hier ja bereits als Standard-Browser installiert. Zusätzlich muss
aus dem Google Play Store die App Google Drive installiert werden. Hiermit können alle in
Google-Office erstellten Dateien verwaltet und betrachtet werden. Allerdings (noch) nicht
bearbeitet werden. (...was zumindest bei einem Handy auch nicht wirklich praktikabel ist).
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Falls man auch Dateien unter Android neu erstellen und bearbeiten möchte, kann man dazu
aus dem Google Play Store die entsprechenden Zusatz-Apps

- Google-Docs
- Google-Präsentationen
- Google Tabellen

installieren. Auch diese sind kostenlos.

Über die Nutzung von Google Office mit anderen Betriebssystemen als Windows und
Android besteht hier leider keine Erfahrung.

1.3 Google-Drive als “Datenzentrale”

Als Einstieg in die Google-Office Umgebung wird im Chrome-Browser in einem neuen

Fenster das Symbol für die Google-Apps (rechts oben) angeklickt, und dann aus dem
aufklappenden Menu “Drive” ausgewählt (siehe Bild).

Falls man noch nicht mit seinem Google-Account angemeldet ist, wird man jetzt dazu
aufgefordert:
Anschließend erfolgt die Aufforderung nach einer Bestätigung in zwei Schritten. Dies
heißt, dass eine SMS, bzw. je nach Einstellung ein pop-up auf dem Smartphone erscheint,
welche bestätigt werden muss.
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Hinweis:

Um die doch etwas umständliche Anmeldeprozedur nicht bei jeder neuen Sitzung
wiederholen zu müssen, kann man im Browser auch angemeldet bleiben. Diese Anmeldung
bleibt dann auch erhalten, wenn der Computer heruntergefahren und wieder neu gestartet
wird.
Aus Gründen der Datensicherheit ist dieses aber NUR FÜR DEN EIGENEN LAPTOP ZU
HAUSE zu empfehlen! Benutzt nämlich eine andere Person diesen PC, hat sie VOLLEN
ZUGRIFF auf alle Dateien in diesem Account, sowie auf die mails im entsprechenden
gmail-Konto, die ggf. abgelegten Fotos in der App Photos etc. etc.

Nach geglückter Anmeldung erscheint auf der linken Seite des Browsers ein Fenster
mit einer Übersicht aller für Google-Office relevanten Dateien. In dem Bild unten ist die
Bedeutung der jeweiligen Überschriften angegeben. Wir werden uns in dieser Übersicht

nur auf die beiden Punkte und eingehen.
Die übrigen Punkte sind analog, bzw. (hoffentlich) selbsterklärend. Jede dieser Übersichten
lässt sich mit dem kleinen Dreieck (Pfeil) auf- , bzw. wieder zu- klappen.
(ganz in Analogie zum Datei-Explorer unter MS-Windows).
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Der für unsere Zwecke wichtigste Punkt ist .
Hier befinden sich (normalerweise) alle Dateien, die in Google-Office erstellt wurden.
Wie in jeder anderen EDV-Anwendung empfiehlt es sich sehr, durch das Anlegen
entsprechender Unterordner Ordnung zu halten (deshalb heißen die auch Ordner ;-)
Klickt man einen (Unter-)Ordner an, erscheinen im rechten Fenster die entsprechenden

Dateien (siehe Bild unten). Neue Dateien entstehen mit dem Button .

1.4 Offline-Bearbeitung

Notwendige Voraussetzung für das Arbeiten “in der Cloud” ist ein Internetanschluss. Die
Dateien werden während der Bearbeitung laufend synchronisiert. Es gibt kein separates
Abspeichern. Alles passiert online. Ist die Internetverbindung langsam, oder immer wieder
mit Unterbrechungen, wird das Arbeiten mühselig. Der Browser sperrt dann die Eingabe
mit einer Meldung “Synchronisierung nicht möglich”, und man muss warten, bis die
Verbindung wieder stabil ist. Arbeitet man mit einer größeren Datei, ist auch das zu
übertragende Datenvolumen relativ groß.
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Es gibt aber (in vielen Fällen, leider nicht in allen) Abhilfe: Einrichten einer
Offline-Bearbeitung. Diese ist aber nicht wirklich geeignet auf Laptops mit vielen Usern, da
PRO LAPTOP NUR EIN Google-Account diese Offline-Bearbeitung aktiv nutzen kann. Ist
diese von einem Account aktiviert, und loggt sich ein anderer Account auf diesem Laptop
ein, erscheint im Status

Wie beschrieben, besteht dieses Dilemma nur in Fällen von schlechter Internetverbindung
in Verbindung mit der Nutzung von öffentlichen Computern. Und natürlich kann eine
aktivierte Offline-Berabeitung auch von dem jeweiligen Nutzer deaktiviert werden, was
dann einem anderen Nutzer wiederum eine Aktivierung ermöglicht.

Zur Aktivierung bzw. Deaktivierung der Offline-Bearbeitung ruft man im Chrome-Browser
eine der Office-Anwendungen auf (z.B. Docs):

Im Startbildschirm von Docs geht man auf die Drei Querbalken links oben und ruft die
Einstellungen auf:
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Darin befindet sich dann der Schalter für die Aktivierung, bzw. Deaktivierung der
Offline-Bearbeitung:

Damit hat man diesen Laptop für sich zur Offline-Bearbeitung eingerichtet.
Um daraufhin eine konkrete Datei auch offline bearbeiten zu können, klickt man in dieser

Datei die kleine Wolke links oben neben dem Dateinamen an und aktiviert dann für
diese Datei die Offline-Bearbeitung.
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Anschließend nochmal bestätigen und die Datei aktualisieren

Das wars. Jetzt kann man auch ohne Internetanschluss an der Datei arbeiten. Die
Aktualisierung in der Cloud erfolgt dann jedes Mal automatisch, wenn der Laptop

Internetanschluss hat. (Sonst natürlich nicht…). Neben diesem Wolkensymbol
erscheinen übrigens immer auch die aktuellen Meldungen zu den Synchronisierungs-
Aktivitäten für diese Datei.

1.5 Freigeben

ALLE Dateien in der Cloud (also nicht nur Office-Dateien, sondern auch z.B. dort abgelegte
Bilder oder andere Dokumente) kann man auch für andere Benutzer (d.h. andere
Google-Accounts)
- nur zur Ansicht (d.h. keine Änderung möglich) , aber auch
- zur Bearbeitung (d.h. Änderung und auch Löschen möglich!)
freigeben.

Alle für mich freigegebenen Dateien erscheinen im Ordner .
Diese Dateien kann man wie jede andere Datei öffnen und bei Änderungsfreigabe (d.h.
“Freigeben für Mitarbeiter”, siehe unten) auch bearbeiten. Hier ist eine gewisse Vorsicht
geboten:
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Die Dateien, die im Ordner erscheinen, sind KEINE Kopien der
freigegebenen Dateien, sondern verweisen auf die ORIGINALDATEIEN in der Cloud des
Freigenden. Das heißt (bei Freigabe zur Bearbeitung), dass jede Änderung (auch Löschung!)
direkt im Cloudspeicherplatz des Freigebenden erfolgt. Dies ist auch sinnvoll, falls Dateien
gemeinsam bearbeitet werden sollen. So hat jeder sofort den aktuellen Stand. Falls man das
nicht will, macht man VORHER eine Kopie seiner Datei, und gibt diese dann frei.

Umgekehrt: Falls man eine freigegebene Datei als eigene Datei behalten will (in der auch
der Freigebende nichts mehr ändern kann), öffnet man die freigegebene Datei und
speichert sie als Kopie in seiner eigenen Cloud ab.

Wir werden das in dem Übungsbeispiel 1.5 nochmal genauer sehen.

Die Freigabe gelingt per rechter Maustaste auf die Datei, und dann
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In dem darauf erscheinenden Fenster trägt man den gmail-Account des Empfängers ein .

Daraufhin erscheint ein Fenster für die Art der Freigabe.

14



Über die möglichen Konsequenzen bei einer Freigabe “Mitarbeiter” wurde weiter oben
schon geschrieben.

1.6 Übungsbeispiel: Gemeinsames Bearbeiten einer Datei

Schritt 1�
Wir erstellen im Ordner Übungsbeispiele eine neue Docs-Datei (Beschreibung von Docs
kommt dann in Kapitel 2), schreiben darin einen Satz und speichern die Datei unter dem
Namen 1.5_Originaldatei
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Wir sehen, es gibt keine explizite Speicherungsfunktion Speichern / Speichern unter etc.
wie in herkömmlichen Programmen. Das ist am Anfang für gewohnte MS Windows-Nutzer
etwas gewöhnungsbedürftig… Den Namen 1.5_Originaldatei erhält die Datei, indem man
ihn links oben einträgt.

Schritt 2�
Wir machen uns davon eine Kopie und nennen sie 1.5_Kopie
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Schritt 3�
Diese Datei geben wir für einen anderen Google-Account (hier
malteser.computerkurs@gmail.com) zur Bearbeitung frei. (Als “Mitarbeiter”)
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Wir sehen jetzt in Drive neben dem Dateinamen das Symbol .Mit Rechtsklick darauf
kann man (unter anderem) auch den aktuellen Freigabestand sehen.

Schritt 4�
Der Account malteser.computerkurs@gmail.com sieht in seiner Cloud diese Datei als
freigegeben. Er öffnet sie (mit Doppelklick)
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Jetzt erkennen beide zwei Cursor:
- der normale schwarze für den eigenen Cursor
- ein violetter für den Cursor des anderen.

Beide können gleichzeitig online in dem Dokument arbeiten.
Jetzt ist klar, dass beide Accounts tatsächlich auf derselben Datei arbeiten.

Jeder der beiden Accounts kann diese Datei auch löschen. Sie ist dann auch für den jeweils
anderen weg! Deshalb haben wir in Schritt 2 auch vorher eine Kopie erstellt.

Schritt 5�
Der Account malteser.computerkurs@gmail.com speichert die Datei bei sich als Kopie ab.
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Wenn er das Freigabe-häkchen nicht setzt, hat er jetzt
eine eigene, eigenständige Kopie, die nicht mehr mit der Datei des Freigebenden
verbunden ist. (Der zweite Cursor verschwindet).
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2. Google-Docs

Wie in 1.1 bereits beschrieben, ist Google-Docs das Pendant zu MS-Word und wird zum
Erstellen von Text-Dokumenten verwendet.
Wir gelangen in die App Docs, indem wir in der App Drive entweder ein bereits
vorhandenes Dokument öffnen, oder ein neues erstellen.

Alternativ können wir die App Docs auch direkt in der App-Übersicht von Google Chrome
öffnen. Dazu im Browser einen neuen Tab öffnen
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2.1 Schreiben und Formatieren

Die grundlegenden Schaltflächen zum Schreiben und Formatieren sind direkt in der
Bearbeitungsleiste zu erreichen und sollen ausprobiert und geübt werden.

Allgemein gilt:

● Geschrieben wird immer da, wo sich der blinkende Cursor befindet (das ist meistens
nicht da, wo der Mauszeiger steht). Um den Cursor an eine andere Stelle im Text zu
bewegen, einfach mit der Maus an diese Stelle klicken (Linksklick).

● Die Formatierungen werden (nur) auf diemarkierten Stellen angewendet. Zum
Markieren einer Stelle:
- Am Anfang der Markierung: Linksklick-Taste festhalten
- Maus bis zum Ende der Stelle ziehen und dann Maustaste loslassen.
Alternative über Tastatur:
- Cursor an den Anfang der Stelle
- Shift Taste drücken und festhalten
- Cursor mit den Pfeiltasten an das Ende der Stelle bewegen und dann Shifttaste
loslassen.
Beispiel: Entfernen aller Formatierungen für zwei Zeilen in der Mitte des Textes:
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● Die letzten Aktionen können jederzeit mit (oder Tastenkombination Ctrl Z)
rückgängig gemacht werden.

2.2 Einfügen von Bildern und Tabellen

Neben reinem Text können auch noch eine Vielzahl von anderen Objekten in das
Dokument eingefügt werden. Hier wird nur auf die gängigsten Elemente eingegangen. Die
anderen Elemente sind zum Teil selbsterklärend oder können bei Bedarf in der
Online-Dokumentation (Aufruf über Hilfe→ Hilfe) nachgeschlagen werden.
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Das Einfügen eines Bildes ist sicher der häufigste Fall.
Die Quelle für das Bild kann dabei der aktuelle Computer, die eigene Google-Cloud (Drive),
oder auch eine Web-Adresse (URL) oder eine angeschlossene Kamera sein.

Man kann aber auch den Inhalt der “Zwischenablage” einfügen. In der Zwischenablage
befindet sich immer das, was zuvor mit einem “Kopieren-Befehl” dort hineingetan wurde.
Der “Kopieren-Befehl” kann auch in einem ganz anderen Programm vorgenommen werden.
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Beispiel: Auf Windows-Rechnern ist das installiert, mit welchem man
beliebige Bereiche des Bildschirms "abfotografieren" kann. Auch dieser Inhalt wird in der
Zwischenablage abgelegt und kann von dort in Google-Docs eingefügt werden (über
Menuepunkt Bearbeiten→ Einfügen (oder Tastenkombination Ctrl V)
Auf diese Weise sind übrigens auch alle Bildschirmbilder in dieses Dokument hinein
gekommen.
Eine weitere Möglichkeit ist das Herunterladen von Bildern aus dem Internet. Dies wird im
Übungsbeispiel 2.5 gezeigt.

Als weiteres Element kann eine Tabelle eingefügt werden:

Ein konkretes Beispiel zur Gestaltung einer Tabelle wird in Übungsbeispiel 2.6 gezeigt.
(Auch in 2.3 ein typisches Beispiel..)
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2.3 Weitere Funktionen

Natürlich hat Google-Docs noch eine Vielzahl weiterer Funktionen. Einige wichtige seien
hier kurz aufgezählt, werden aber nicht weiter im Detail erklärt:

Funktion Aufruf Kurzbeschreibung

Seiteneinrichtung Datei → Seiteneinrichtung Seitengröße, -farbe und -format, Größe der
Ränder etc.

Seitennummern, Kopf-
und Fußzeilen

Einfügen → Seitennummern bzw.
Kopf- und Fußzeilen

Mehrspaltiger Text Format → Spalten Zum Aufteilen eines Text-Abschnittes in
mehrere Spalten: Text markieren und dann
Formatierung in Spalten

Fertige Bausteine Einfügen → Bausteine Eine Auswahl öfter zu verwendender fertig
formatierter Tabellen etc. aus dem
Office-Bereich

Rechtschreibkorrektur Tools → Rechtschreibung und
Grammatik

Die automatische Rechtschreibkorrektur ist
standardmäßig auch während des Schreibens
aktiv. Rechtsklick auf die Rot unterringelten
Worte.

Spracheingabe Tools → Spracheingabe funktioniert erstaunlich gut ….

Übersetzen Tools → Dokument übersetzen Ca. 50 Sprachen stehen zur Auswahl

Tastenkombinationen Hilfe → Tastenkombinationen Power-Nutzer eines jeden Programms
verwenden im Laufe der Zeit immer mehr sog.
“Shortcuts” für die Befehle, statt sie per Maus
und Menu einzugeben. Kann die
Arbeitsgeschwindigkeit verdoppeln und die
Handgelenke schonen…

Links einfügen Einfügen → Verlinken Praktisch alles kann mit einer URL verknüpft
werden.

Kommentierfunktion Beim Markieren eines Textes

erscheinen immer die Icons

Das Design von Google Office ist komplett
Cloud-basiert und damit perfekt geeignet für
kollaboratives Arbeiten. Dementsprechend hat
es ein Instrumentarium zum Kommentieren,
Vorschlagen von Änderungen,
Versionsmanagement etc.

Hilfefunktion Hilfe → Hilfe Hilfe!, Hilfe!!

26



2.4 Exportieren als .pdf oder .docx, Drucken oder Versenden

Dieses Kapitel gilt auch für die anderen Apps Präsentationen (Kaptiel 3) und Tabellen
(Kapitel 4).

Wenn ein Drucker zur Verfügung steht, kann die Datei über Klick auf das Symbol
ausgedruckt werden. Zum Versenden per mail oder Whatsapp etc. empfiehlt sich das

Abspeichern im .pdf-Format. Dazu wählt man im Druckmenu als Ziel und
speichert die Datei lokal auf dem Laptop an geeigneter Stelle ab.

ACHTUNG: Eine Datei im .pdf-Format eignet sich NICHT zum weiteren Bearbeiten. Es ist
eher wie “Drucken in eine Datei”. Um die Datei als MS-Word Datei abzuspeichern, wird sie
in Drive per Maus-Rechtsklick heruntergeladen. Sie wird im Download-Verzeichnis des
Chrome-Browsers gespeichert.

27



2.5 Übungsbeispiel: Ein Liedtext aus dem Internet mit Bild

Zum Üben verschiedener Formatierungsoptionen für Text, sowie das Einfügen von Bildern
gehen wir ins Internet und suchen nach einem Liedtext. Wir haben uns das Lied
“99 Luftballons” von Nena ausgesucht. Der Text dazu ist im Internet leicht zu finden, z.B.
https://www.songtexte.com/songtext/nena/99-luftballons-63dcfa57.html.
Natürlich kann man sich auch das Lied anhören und über den Text sprechen. z.B.
https://www.youtube.com/watch?v=Fpu5a0Bl8eY
Wir haben den Text zweispaltig formatiert und noch ein Bild aus dem Internet eingefügt.
Hier unser Ergebnis:
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2.6 Übungsbeispiel: Eine Tabelle mit deutschen Sprichwörtern

Zum Üben der Funktionen einer Tabelle haben wir uns aus der Quelle
https://karrierebibel.de/sprichwoerter/ bedient, zu den einzelnen Sprichwörtern noch ein
Bild aus dem Internet gesucht und das ganze in einer Tabelle formatiert.

Sprichwort Bedeutung Bild

E� is� nich� alle�
Gol�, wa�
glä��.

Nach außen mag es toll aussehen, doch sollten
Sie sich nicht davon täuschen lassen. Der erste
Schein kann trügerisch sein. Bei genauer
Betrachtung zeigt sich der wahre Wert – oder der
wahre Charakter eines Menschen. Denn auch
Versprechungen, die toll klingen, werden nicht
immer eingehalten.

Der Apfe� fäll�
nich� wei� vo�
Stam�.

In Kindern zeigt sich oft nicht nur das Aussehen
der Eltern, sondern auch deren Eigenschaften
oder Charakterzüge. Diese Ähnlichkeit im Wesen
bringt das Sprichwort zum Ausdruck.

Morge�-
stun� ha� Gol�
i� Mun�.

Frühaufsteher haben mehr vom Tag und in den
ersten Stunden des Tages lässt sich besonders
gut und erfolgreich arbeiten. Frühaufsteher
können das bestätigen – auch wenn Langschläfer
mit anderer Chronobiologie der Morgenstund
nichts abgewinnen können.

Kindermun� tu�
Wahrhei�
kun�.

Während Erwachsene sich zurückhalten oder zu
einer Notlüge greifen, sind Kinder direkt und
ehrlich. Sie haben noch nicht gelernt, sich zu
verstellen und sprechen auch unangenehme
Wahrheiten unverblümt aus.

Viel� Köch�
verderbe� de�

Bre�.

Unterstützung kann hilfreich sein, doch zu viele
verschiedene Ansätze, Meinungen und Hände,
die gleichzeitig etwas tun, sorgen nur für Chaos.
Manchmal ist eine klare Zuordnung von Aufgaben
besser.
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3. Google-Präsentationen

3.1 Grundlagen: Was unterscheidet Präsentationen von Docs?

Auf den ersten Blick kann man sowohl in Docs als auch in Präsentation sehr ähnliche Dinge
machen. (Texte, Bilder, Tabellen etc..). Warum also zwei verschiedene Apps? Hier ein kurzer
Versuch zur Erklärung der Unterschiede:

Docs Präsentationen

Aufbau Ein beliebig langer Text, der sich
auf die dafür benötigte Anzahl von
Seiten erstreckt. In diesen Text
können weitere Objekte (Bilder,
Tabellen usw.) eingebettet sein. Sie
sind dann Teil des Textes. Das
heißt, sie bleiben immer an der
selben Stelle des Textes und
werden z.B. mit ihm verschoben,
wenn man vorher weiteren Text
einfügt.

Eine Präsentation besteht aus
beliebig vielen Folien (= einzelnen
Seiten). Diese Folien stehen jeweils
alleine für sich. Auf jeder Folie können
verschiedene Objekte frei positioniert
werden. Ein Textobjekt wird dabei
genau so behandelt, wie jedes andere
Objekt. (Und muss auch wie jedes
andere Objekt auf eine Folie passen)

Ergebnis Ein Dokument mit fortlaufenden
Seiten (“wie ein Buch”)

Ein Dokument mit Einzelfolien
(“wie ein Diavortrag”)

Anwendungs-
beispiele

Längere Texte jeder Art,
Bedienungsanleitungen,
Bewerbungen …

Präsentationen jeder Art für
Zuschauer (vom Computer auf einem
Bildschirm oder Beamer zum
Durchblättern der einzelnen Folien).
Aber auch Grafiken, Bildmontagen,
Einladungs- und Glückwunschkarten
...

Wir gelangen in die App Präsentationen, indem wir in der App Drive entweder ein bereits
vorhandenes Dokument öffnen, oder ein neues erstellen (ganz analog zu Docs im letzten
Kapitel).
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Alternativ können wir die App Präsentationen auch direkt in der App-Übersicht von Google
Chrome öffnen. Dazu im Browser einen neuen Tab öffnen
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3.2 Einige Objekte: Text, Formen, Bilder

Hier die wichtigsten Elemente des Startbildschirms:

Allgemein gilt:

● Jede Folie besteht aus einer Ansammlung von verschiedenen Objekten. Zum Start
sind bereits die beiden Textobjekte (siehe oben) vorhanden. Bevor ein bereits
vorhandenes Objekt bearbeitet werden kann, muss es per Mausklick ausgewählt

werden. Dazu muss die Schaltfläche aktiviert sein. (Erste Übung: Anklicken und
Löschen der beiden vorhandenen Textobjekte).

● Ist ein Objekt ausgewählt (angeklickt), so erscheint ein Auswahlrahmen zur
Kennzeichnung des ausgewählten Objekts, sowie die entsprechenden Schaltflächen
zur Änderung / Formatierung.

● Bewegt man den Mauszeiger über den Auswahlrahmen, verändert er die Form (siehe
Bild). Je nachdem, welche der Formen der Mauszeiger hat, kann man durch
Linksklick und Taste halten dieses Objekt entsprechend bewegen, bzw. vergrößern
oder verkleinern.
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Wir wollen das ganze jetzt mit verschiedenen Objekten aus den Auswahllisten

üben:

● Einfügen, Löschen
● Bewegen, Drehen, Vergrößern, Verkleinern
● Farbe, Umrandung, Texte ändern
● Verändern der Form mit den gelben Punkten
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3.3 Gruppieren, Anordnen und Ausrichten der Objekte

Beim Üben haben wir bereits festgestellt, dass es bei vielen Objekten auf einer Folie schnell
schwierig wird, präzise und effizient zu arbeiten. Deshalb hier dazu einige nützliche
Funktionen:

1. Auswahl mehrerer Objekte:
Man kann mit der Maus durch “Linksklick - Taste Halten - Maus bewegen - Taste
loslassen” (abgekürzt: “Ziehen”) einen Auswahlrahmen aufspannen. Alle Objekte, die
in diesen Rahmen hineinreichen (sie müssen nicht ganz drin sein), werden
ausgewählt und können gemeinsam bearbeitet werden.
In diesem Beispiel werden die Textobjekte 3, 4 und 5 ausgewählt.
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Sind bereits Objekte ausgewählt, können durch Drücken der Strg-Taste weitere
Objekte hinzu gewählt werden. Werden bei gedrückter Strg-Taste bereits
ausgewählte Objekte erneut ausgewählt, deaktiviert das diese Auswahl (sogenannte
“Toggle”-Funktion).
In diesem Beispiel kann man so die Textobjekte 1, 2, 4 und 6 auswählen.

2. Gruppieren von Objekten:

Ausgewählte Objekte können per Rechtsklick und (oder Taste zu
einer Gruppe zusammengefasst werden. Sie werden dann “wie ein einziges Objekt”

behandelt. Auflösen dieser Gruppe analog durch .
Gruppieren ist vor allem auch sinnvoll, wenn man mehrere Objekte gemeinsam
vergrößern oder drehen will, ohne die relative Ausrichtung der einzelnen Objekte
zueinander zu verändern.

3. Verschieben von übereinanderliegenden Objekten “nach vorne” bzw. “nach hinten”

Die einzelnen Objekte werden bei der Erzeugung quasi “von oben” auf die Folie
gelegt. Überlappen sich zwei Objekte, so verdeckt das später erzeugte Objekt das
schon vorhandene. Diese Reihenfolge lässt sich über Anordnen→ Reihenfolge gezielt
verändern: Entweder “um eine Lage nach vorne/hinten bringen oder ganz in den
Vordergrund / Hintergrund. Hinweis: Hat man da mehr zu tun, empfehlen sich sehr

die entsprechenden “Shortcuts” usw.
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Beispiel: Mit Auswahl von Objekt 1 und wird dieses “ganz nach
vorne” gebracht.

4. Ausrichten und gleichmäßiges Verteilen

Durch Anordnen→Ausrichten und Anordnen→Verteilen lassen sich Objekte schnell
regelmäßig anordnen:
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Beispiel: Mit den beiden Befehlen Anordnen→Ausrichten→Zentriert und
Anordnen→Verteilen→Vertikal lassen sich diese fünf Objekte schnell regelmäßig
anordnen.

3.4 Animation in der Diashow

Wie der Name dieser App schon verrät, ist die Präsentation vor Publikum eine der

Hauptfunktionen. Dazu dient die Schaltfläche rechts oben. Sie zeigt die
einzelnen Folien im Vollbildmodus.

● Mit den Pfeiltasten werden die Folien vor- bzw. zurückgeblättert
● Die Pos 1 - Taste springt ganz an den Anfang, die Ende-Taste ans Ende.
● Zurück in den Bearbeitungsmodus geht es mit der Esc-Taste.

Darüber hinaus können die einzelnen Objekte auf einer Folie auch noch (gleichzeitig oder
hintereinander) animiert werden. Dazu das entsprechende Objekt anklicken und über
Animieren→ Erscheinen die entsprechende Animation auswählen (siehe Bild). Auch der
Übergang zwischen den einzelnen Folien kann so animiert werden (Folienübergang). Unten
im Bild rechts ist als Beispiel eine Animation von vier Objekten und zusätzlich noch ein
Folienübergang (“Galerie”) definiert. Getestet wird die Show über die Schaltfläche
Abspielen.
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3.5 Weitere Funktionen

Analog zu Google-Docs gibt es auch in Präsentationen noch eine Vielzahl weiterer
Funktionen. Einige wichtige seien hier kurz aufgezählt, werden aber nicht weiter im Detail
erklärt:

Funktion Aufruf Kurzbeschreibung

Folien-Layout und
-Design

Es gibt eine Vielzahl vorgefertigter Designs und
Layouts für professionell wirkende
Präsentationen.

Formatierungsoptionen Auswahl eines Objektes und Klick
auf die Schaltfläche

Es erscheint auf der rechten Seite ein Fenster
mit allen zur Verfügung stehenden Optionen für
das ausgewählte Objekt. Diese sind zum Teil
deutlich umfangreicher als in Docs.

Erweiterte
Zuschneide-Funktion für
Bilder

Auswahl eines Bild-Objektes, dann
Auswahl der Zuschneide-Funktion

(Fast) alle in 3.2 beschriebenen Formen lassen
sich auch als Begrenzung für ein Bild
verwenden. (Oft genutzt: Eine runde oder ovale
“Bildplakette”).
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Schlagschatten und
Reflexionen

Über die Farmatierungsoptionen
(s.o.)

Erzeugt entsprechende “Hingucker”...

Audio und Video Einfügen → Audio bzw → Video Es lassen sich auch Audio und Video in eine
Präsentation einbinden.

Rechtschreibung,
Wörterbuch,
Spracheingabe,
Kommentarfunktionen,
Foliennummer,
Verlinkungen, …

Analog zu Google-Docs (Kapitel
2.3)

3.6 Übungsbeispiel: Gestalten eines Gutscheins

Zum Üben für das Arbeiten mit Google-Präsentationen wollen wir für ein Geburtstagskind
einen Gutschein für eine gemeinsame Zugfahrt zum Tegernsee entwerfen.

Schritt 1: Eine Zugfahrkarte
Da wir eine Zugfahrt schenken wollen, liegt es nahe, eine Fahrkarte in den Gutschein mit
aufzunehmen. Diese soll ein wenig “bayrisch” wirken (Fahrt zum Tegernsee!), sowie als
Fahrkartennummer das Geburtsdatum des Geburtstagskindes enthalten. So eine Karte
findet man schwer als Bild im Internet. Also “basteln” wir in Präsentationen selbst eine:
Wir starten mit einer “Doppelten Welle” aus den Legenden. Diese drehen wir um 90°, und
kürzen über den “Gelben Punkt” die Wellen
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Jetzt viermal kopieren und schön aneinanderreihen. Anschließend die Ränder transparent
machen, den oberen und unteren Streifen blau einfärben, sowie die mittleren drei Streifen
hellgrau.

Noch zwei Linien und zwei Textobjekte, schön hindrehen, und voilà! Die Fahrkarte ist
fertig.

Schritt 2: Zwei Bilder aus dem Internet
Wir suchen uns im Internet
- ein Bild vom Tegernsee
- ein Bild von einem Zug in weiß-blau (mit transparentem Hintergrund!)
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Schritt 3: Zusammenbauen und Text
Das ganze kopieren wir jetzt in einer neuen Folie zusammen und fügen noch einen
Textbaustein, sowie einen Schlagschatten hinter dem Gutschein hinzu. Fertig!
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4. Google-Tabellen

4.1 Grundlagen: Was ist eine Tabellenkalkulation?

Google-Tabellen ist ein typisches Programm zur Tabellenkalkulation und wie die vorher
besprochenen Programme in Bedienung und Funktion eng an die entsprechenden
Produkte von Microsoft angelehnt (siehe Kapitel 1.1). Wie der Name schon sagt, liegen die
Stärken einer Tabellenkalkulation in der Kalkulation. Das heißt, dass sowohl einfache als
auch sehr komplexe Berechnungen automatisiert durchgeführt werden können. Außerdem
lassen sich die Ergebnisse dieser Berechnungen in Form geeigneter Grafiken
veranschaulichen.

Kleinster Baustein ist eine sogenannte Zelle. Diese kann enthalten:
● einen Text
● eine Zahl (oder ähnliches, womit sich rechnen lässt, kann z.B. auch ein Datum sein)
● eine Rechenvorschrift (“Formel”), wie sich der Inhalt dieser Zelle aus dem Inhalt von

anderen (meist benachbarten) Zellen berechnet.

Dies ist der eigentliche Kern einer Tabellenkalkulation: Kalkulationmit Zellen, welche in
Zeilen und Spalten zu einer Tabelle angeordnet sind.

Ein einfaches Beispiel soll dieses Prinzip veranschaulichen: Der Kassenbon.
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4.2 Erstellen, Bearbeiten und Formatieren von Datenfeldern

Das Beispiel “Kassenbon” wollen wir jetzt in Google-Tabellen umsetzen.
Wir tragen zuerst den Text ein und formatieren ihn mit den (bereits aus Docs und
Präsentationen bekannten) Schaltflächen. Dies soll hier ausprobiert und geübt werden.

Jetzt befüllen wir die Datenfelder (Spalten B, C und D) und formatieren diese nach der
jeweiligen Datenart.
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4.3 Berechnungen

In den Berechnungen (“Formeln”) steckt die eigentliche Tiefe und Komplexität einer
Tabellenkalkulation. Es sind hier sehr (sehr, sehr) viele Arten von Berechnungen (Statistik,
Trigonometrie, Finanzwesen, Datenbankfunktionen, Wenn-Dann Bedingungen,
Summe-Wenn Funktionen etc. etc. möglich. Alle diese Funktionen verbergen sich hinter

der Schaltfläche Das Bild unten gibt uns einen Eindruck für die möglichen Funktionen
z.B. im Bereich der Mathematik.
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Für unser Beispiel kommen wir aber mit den Grundrechenarten (plus +, minus - mal *,
sowie der Summenfunktion SUMME) aus.
Wichtig: Wollen wir in eine Zelle eine Formel (Berechnungsvorschrift) schreiben, beginnen
wir immer mit dem Gleichheitszeichen =.

Schritt 1�
In einem ersten Schritt wollen wir den Preis für die Butter in Zelle E2 berechnen.
Dieser ergibt sich zu:
Anzahl * Einzelpreis * (1 - Rabatt_in_%).
In der “Zellen-Notation” wird daraus =C2*B2*(1-D2)
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Wir müssen dabei die “Adressen” der für die Berechnung verwendeten Zellen nicht direkt
eintragen. Es genügt das Vorgehen
=
Linksklick auf Zelle C2
*
Linksklick auf Zelle B2
*(1-
Linksklick auf Zelle D2
)
Entertaste

Schritt 2�
Diese Formel gilt natürlich auch für alle weiteren Waren (so ist das meistens bei einer
Tabellenkalkulation. Die Rechenschritte sind oft dieselben, nur mit anderen Eingabedaten).
Deshalb geht das Erweitern auf die anderen Waren (Zeilen 3 bis 16) auch sehr schnell. Wir
kopieren einfach den Inhalt (d.h. die Formel) der Zelle E2 auf die Zellen E3 bis E16. Das geht
“konventionell” wie in Docs oder Präsentationenmit Rechtsklick “Kopieren” (oder Taste
Strg-C), markieren der Zielbereiche E3 bis E16, Rechtsklick “Einfügen” (oder Taste Strg-V).
Noch schneller, und nur für die App Tabellen:
Wir ziehen den Rahmen der Zelle E2 runter bis E16.

Klicken wir dann eine der anderen Zellen in Spalte E an (im Bild oben rechts die Zelle E3),
erkennen wir, dass das Programm beim Kopieren der Zellen “intelligent” vorgegangen ist.
Das heißt, dass die Zeilennummern der jeweiligen Formel beim Kopieren entsprechend der
Position mit hochgezählt wurden.
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Hinweis:
In den meisten Fällen (auch hier) entspricht dieses “intelligente” Hochzählen der Zeilen-
bzw. Spaltennummern beim Kopieren von Formeln genau der Absicht. Manchmal will man
das aber auch gerade nicht (z.B. wenn eine ganze Zeile oder Spalte immer mit einer Zahl in
derselben Zelle multipliziert werden soll). Auch das geht. Man kann in der ersten Formel
auch Spalte, Zeile (oder beide) mit einem vorangestellten Dollarzeichen $ quasi “für das
Kopieren festpinnen”. Also Formeln wie =$C$2*B$2*(1-D2)→ ausprobieren!

Schritt 3�
Jetzt fehlt nur noch die Summe der Preise aus Spalte E. Dazu geben wir in Zelle E17 die

entsprechende Formel ein (oder wählen sie mit der Schaltfläche aus). Auch hier
müssen wir nicht explizit die Zellen E2�E16 eingeben. Der Zellbereich für die
Summenbildung kann auch per “Mausziehen” ausgewählt werden.

4.4 Erstellen von Diagrammen

Eine weitere mächtige Eigenschaft von Programmen zur Tabellenkalkulation ist das
Visualisieren von Datenfeldern über entsprechende Diagramme. Auch dies ist ein sehr
weites Feld… Als kleines Beispiel hier nur die Darstellung der Spalten A und E (Produkt und
Preis) in der Form eines klassischen Balkendiagramms.
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Dazu die beiden Spalten A und B (jeweils Zeilen 2 bis 16) markieren. Anschließend über
Einfügen→ Diagramm ein “Standarddiagramm” zur Darstellung von zwei Spalten erstellen
(in diesem Fall ist das ein Tortendiagramm). Doppelklick auf dieses Diagramm öffnet dann
rechts den Diagrammeditor, in dem man auf Balkendiagramm umstellt. Vom Diagramm-Typ
über Flächen- und Linienfarben, Achsenskalierung und -Beschriftung, Datentypen etc. etc.
kann alles angepasst werden.
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